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Release Notes for RobotStudio 2023.4

General

The release name is RobotStudio 2023.4 and the build number is 23.4.10603.0. The build date is
December 13, 2023.

User documentation

The RobotStudio Operating Manual is available in all languages supported by RobotStudio except Czech,
i.e. English, German, French, Italian, Chinese, Japanese, Spanish. RobotWare manuals for IRC5 and
OmniCore can be installed fromthe Add-Ins Gallery.

Tutorials

Tutorials are available at the RobotStudio product pages at
https://new.abb.com/products/robotics/robotstudio.

System Requirements
Required Software

Microsoft Windows 10 Anniversary Edition or later, 64-bit edition, is required.

The Windows App Installer is a pre-requisite for the virtual OmniCore FlexPendant software, see
https://www.microsoft.com/en-us/p/App-Installer/9NBLGGH4NNSL. The App Installer is a default built-
in app in Windows 10 and later, but may have been removed on some PCs.

Sideloading of apps must be enabled on Windows to install the virtual OmniCore FlexPendant.
To enable sideloading follow these steps:

1. Open Settings.
2. Click Update & Security (Windows 10) or Privacy & security (Windows 11) > For developers.
3. Ensure Developer Mode is set to On.

Recommended Hardware

ITEM REQUIREMENT
CPU 2.0 GHz or faster processor, multiple cores recommended

8 GB minimum

Memo

v 16 GB or more if working with large CAD models
Disk 10+ GB free space, solid state drive (SSD)
Graphics High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors.
Card* For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.
Screen . . .

. 1920 x 1080 pixels or higher is recommended

Resolution
Mouse Three-button mouse
3D Mouse Any 3D mouse from 3DConnexion, see http://www.3dconnexion.com.
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ITEM REQUIREMENT

Meta Quest 2, HTC Vive or any Windows Mixed Reality Headset. Note that special PC hardware

Virtual
Realit requirements apply when using RobotStudio with VR, see https://www.oculus.com/oculus-ready-
Headsyet pcs/, https://www.vive.com/us/vive-ready/, or, https://www.microsoft.com/en-us/mixed-

reality/windows-mixed-reality, respectively.

! RobotStudio will not benefit fromthe additional features of so-called ‘Professional’ or ‘Workstation’
graphics cards. The price level of these are at a much higher range than gaming graphics cards with
comparable performance. High-end gaming PCs are very suitable for offline programming with
RobotStudio. Such a PC will provide good performance for a limited budget.
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New Functionality
¢ Exclude occluded geometry when exporting to 2D drawing
e Add-Ins Gallery updated
¢ Dedicated Panel for Collision Free Path results
e Freehand Move and Rotate combined
e Keyboard shortcuts guide
¢ New unified Ul for opening local projects
e New Virtual Controller updated
e Nonstandard datatypes in OPC UA Client
¢ Notification Center
e Rename signals and properties
e Show virtual network
¢ Simulation models distributed separately
e Smart Component Combine/Split
e Smart Component multi-selection

Exclude occluded geometry when exporting to 2D drawing

Added an option to exclude geometry that is not visible from the selected viewpoint when exporting
the station to a 2D drawing in DXF or SVG format.
This can significantly reduce the size of the resulting file and the time to generate it.

| Export Geometry: (Station) | T X
Format
SNVG v
Viewpoint
Top ¥

[] Export invisible objects

[] Bxclude occluded geometry |

"] Only export objects intersecting the floor
Floor height (mm)

0.000 =

| Bxport.. | [ Close

Add-Ins Gallery updated

The appearance of the Add-Ins Gallery has been updated.
There are now different tabs for RobotWare (including Add-Ins), RobotStudio Add-Ins and RobotStudio
Models. This replaces the functionality for filtering by Tags.
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Gallery =

Robotware | RobotStudio Add-Ins | RobotStudio Models | Updates

RobotWare
RobotWare for RobotWare for IRCH Robot\Ware
OmniCore Documentation Package
,;;: H for IRCS
—r L ses ABB ABB
Raobaot\w/are is a family of controller Robat\Ware is a family of controller Raobat\are Documentation Package
software with powerful functions for software with powerful functions for with a documentation set relevant far
controlling robats and penpheral controlling robots and penipheral Raobat\ware IRCS version 6.15 an__.

equipment. equipment.

For RobotStudio Models, it is possible to install all or multiple selected packages in one operation.

Gallery x

Robot\Ware | RobetStudio Add-Ins | RobotStudio Models | Updates

Q

||Ad|:|SeIected || Add Al |

CRB 1300 Il t)f' CRB 15000

{; ABB ‘4 ABB ABB

CRE 1100 simulation models and Virtual CRE 1300 =imulation models and Virtual CRE 15000 simulation models and
Controller templates. Cantroller templates. Virtual Controller templates.

= IRB 1100

IRB 1010 m ! = IRB10%0 I
ABB g ABB ;1’" ABB

Requires Robat\Wfare 7.5 IRE 1090 simulation models and Virtual IRE 1100 simulatian models and Virtual
Controller templates. Controller templates.

The Add-Ins browser has also been updated with folders instead of headers for the different package

categories.

[Adains| s x
[ Add-Ins
General
55 30 Printing
5:} 10 Engineering
E:} Visual SafeMove 2
[ Installed Packages
[ FobatWare
[ RobotWare Add-Ins
[ Robot Studio Add-Ins
[ Robot Studio Models

OO

Dedicated Panel for Collision Free Path results

A dedicated panel has been implemented for displaying all results related to collision-free paths. If a path
cannot be created due to a collision at the target or if the target is unreachable, users can easily
visualize the error by double-clicking on the error item.
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Output | Collision Free Path |

4 @ Joint Target_1 has (2) collision(s)
e IRB1660ID_6_155_real collides with 3HKADDOD0202342 at Joint Target _1
e IRB1660I1D_6_155_real collides with 23HKADDOD0202342 at Joint Target _1
4 e Joint Target_4 has {2) collision(z)

° IRB1660ID_6_155_real collides with 3HKADD000202342 at Joint Taroet_4

e IRB1660I10_6_155_real colides with 3HKADDOD0202342 at Joint Target_4

Freehand Move and Rotate combined

The freehand "Move" and "Rotate" modes have been combined into a single "Move and Rotate" mode.

Labels have also been added to the items in the Freehand menu.

Before:
World b4
Freehand

'-—-.._____.

g

After:
Reference | Waorld ¥ .@)Jog.loint
Pivot Point | Selected Point A @Drag
I-}— Move and Rotate I &® Multi Robot Jog ~

Freehand
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When moving or rotating an object the offset fromthe start position is displayed next to the axis. It is
also possible to manually type in an offset.

Offset (mm)
v 35326M

{ T~

Select the "Reference" option in the dropdown menu to show the position relative to the selected
reference coordinate system, instead of the offset fromthe start position.

Offzet (mmy

- 353 2677
T

Relative to:
| Start (Offset)
Reference (Position/COrientation)

L

Show values relative to the reference coordinate system

Press the Ctrl key when moving or rotating to snap to increments. Press Ctrl+Shift to snap to fine
increments. For linear movement the size of the increments depends on the zoom level. For rotation the
increments are 5 degrees and the fine increments are 1 degree.
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Offzet (mm)

@; Y- 250.0000
-~

Offset (deg) v
RZ: 35,00000

Use the plane handles to move the object along the selected plane.

Dffset (mm) ~

X -839.2137 [ 1241.2255

Keyboard shortcuts guide

A guide of available keyboard and mouse actions has been added to the 3D graphics view.
By default, the guide shows the keys used for navigating the 3D view. When using freehand
manipulation, the guide shows keys for incremental and precision movement.

& @ Zoom @)@ /[ct) [shif) @) Rotate [ctl) @) Pan

The guide can be shown and hidden fromthe Graphics Tools - Settings menu or with the Ctrl+Space
keyboard shortcut.
The default visibility of the guide can be set in Options - Graphics - Appearance.

New unified Ul for opening local projects

There is now a new view "This PC" under File > Open > Local for viewing and opening local projects.
The "Recent" view under File > Open has also been redesigned with a similar appearance.
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This PC
® Recent

ChUsers\mas  Documents\RobetStudic\Projects - III )
Project1
Cloud
Q Newest first v =
@ RobotStudio Cloud
Last edited
A
Project1 Just now
Local Local Droject
L hispe
F—
B Cpen Demo Solar Simulation2 9 day(s) ago
Local Project
Samples
E Demo Stations

Demo AW Station 22 day(s) ago
. Local Project Project Information

Last edited: Just now

Size: 130,9 MB

Author: L ]
LaserScannerSetup_Testing17 ok: 2022 Location: C\Users'msias Documents\RobotStudic\Projects
Local Project Description

Virtual Controllers

CRB15000_5_95 7.12.0-1309.RC

New Virtual Controller updated

The user interface for creating a new Virtual Controller has been updated. This is used when creating a
new Project or adding a new Virtual Controller.
The robot model is now selected first, then the robot variant. A thumbnail is shown for the robot model.

Controller
Name:
IRB1200_5_50

Location:
C\Users s Documents\RobotStudic\Virtual Controllers IZI

(@) Create New

() Create From Backup

Robot Model: Q

rﬁ. IRB 1200 v
]

Wariant:

IRE 1200 5kg 0.9m )
Robot\ware:

7.100 v
Controller

E10 v

[] Customize Cptions

When creating a Virtual Controller froma backup, it is now possible to remove RobotWare add-ins from
the controller.

Note that this might cause the controller to malfunction, for example if there is RAPID code that
depends on the add-in.
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(@ Create From Backup
Select Backup:
CAUsers g Documents"uFiobotStudio".BackJ_lps".DmniCoreArc_BﬁIZI
Only select backups from trusted sources
Robatnfare:
780 ¥
Criginal Version: 7.8.0
GoFakrc:

1.00 -

Criginal Version: 1.0.0+121
Restore backup Include Safety Settings

Nonstandard datatypes in OPC UA Client

The OPC UA smart component now supports some nonstandard datatypes. If the datatype tree on the OPC UA server contains
subtypes of the standard types, they will be recognized by the smart component. For example, arrays of the BYTE datatype

with ID 3001 (common on Siemens PLCs) can now be used.

Notification Center

Added a popup for showing different kinds of user notifications.
The popup is opened by clicking the Notification icon in the title bar. The icon has a blue dot if there are
any new (unread) notifications.
Notifications include updates for RobotStudio and add-ins, new and updated simulation models and
license information.

i

Notifications

. Activate RobotStudio

Your license will expire in 5 days

Click here for options

Just now

© What's new in RobotStudio 2023.4

Click here to view the Release Notes

1 hour(s) ago

© Updates for models are available

Review updates

1 hour(s) ago

Rename signals and properties

Station and Smart Component signals and properties can now be renamed by right-clicking the signal or

property in the Station Logic Design tab and selecting "Properties". Previously the field for the signal
name was read-only.
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{&F SmartComponent 1
Froperties
myProp1 (0)
myProp2 (0)
1/0 Signals
mylnSig0 (0) myOutSig0 (0)
InSig1 {0} myOutSig1 (0)
mylnSig1 (0) InSig2 (0) myOutSig2 (0)
Properties
Delete
Edit mylnSig1 ? d
Type of Signal
DigitalInput [] Autoreset
Signal Baze Mame
|m}'NewSignalName| |
Group
Signal Value 0.00 = 0.00 iz
o |
Display name Description
|m}lln5ig1 | |
[] Hidden [] Read-only
] Show as command in cortext menu
Cancel

Show virtual network

For RobotWare 7.13 or later, "Virtual' networks are displayed in the controller tree.

g b e e

SC_Feedback_Net
4 Virtual
El wirtual_1
El virtual_2
El virtual_3
RAFID

[t

Simulation models distributed separately

Simulation models for robots and other equipment are no longer included in the RobotStudio
distribution. This means that the distribution is significantly smaller, and models can be added or
updated without having to update RobotStudio. The models are distributed as packages that can be

installed fromthe Add-Ins Gallery.

Gallery X

Robot\Ware | RobotStudio Add-Ins | RobotStudio Models | Updates

Q

Robots
& . CRB1I00 [] e CRBI300
E ABB g ABB

CRE 1100 simulation models and Virtual
Controller templates.

O , IRB 1010
L~
\ ABB
=
Requires Robot\are 7.5.

CRE 1300 simulztion models and Virtual
Controller templates.

O swc-. IRB1090

g ABB

IRB 1090 simulation models and Virtual
Controller templates.

Add Selected

CRE 15000

D gty
ABB

CRB 15000 simulation models and
Virtual Contraller templates.

i ABB

IRE 1100

IRE 1100 simulation models and Virtual
Controller templates.

CRB 15000
ABB

Version: 20 v
] Published: 2023-07-13
Size: 1ME

D -
CRE 15000 simulation models and Virtual Controller
templates

Content

CRB15000 10kg 1.52m
CRB15000 12kg 1.27m
CRE15000 5kg 0.95m
Links

Download file
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Model packages can also be installed on-demand from the ABB Library menu or when creating a new
Virtual Controller. A model that is not installed is indicated by a download symbol.

S @ :!E D&o Z @ @..@ 5 Teach Targei
ABB

ETeach Instru

Import Virtual Import Frame | Target Path  Other | _
Library~ Library~ | Controller+ | Geometryw w w - - &2 View Robot
Articulated Robots ~
B P ([T
- “ h- ] :
- 7 & Y
IRB 120 IRE 140 IRE 480 IRE 660 IRB 760

g E 2 E g‘&. gﬁ&,

IRE 1010 IRB 1080 IRB 1100 IRB 1200 IRE 1300
Add Mew Controller 7 ot
Controller
Name:

IRB1 100_4_47.1 |

Location:
C:ilUsersisejoweiDocuments|RobotStudio\Virtual Controllers | . |

(@ Create New

(") Create From Backup

Rokbot odek: [CEE

Eﬁi IRE 1100 v
E” IRB 1100 B
P IRE 1200 4
: [
r IRB 1300 &

Smart Component Combine/Split

It is now possible to select multiple Smart Components and combine theminto a single component. A
Smart Component can also be split it into its components.

Combine:
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Ho FSmartComponent_2

Properties

c (Hello)

{&FSmartComponent_1

1f0 Signals

Froperties

a [Hella)

{2}SmartComponent_4

Properties

10 Signals

b (World) Ho FSmartComponent_3 | —*

e (Hello)

f (World)

Properties

d (World)

110 Signals

Show unused Zoom:

|:| Auto Arrange

Split:

Duplicate...

Cut Ctrl+X (0 Signals
Copy Ctrl+C
Paste Ctrl=V

Save As Library...

ODE v EBR

Disconnect Library

Protected

Examine

Unexamine

Set as UCS

Visible Ctrl=D

Pasitian

e QR @

Set Local Origin
Path Planning

S %

Attach to

Auto Connect Signals

[ simulate

ﬁ Edit Component

(o8] rCombine Components l\

1||= | Split Component
?c+ Properties

fEa Group
£ -

Combine Components

Combine selected smart
components into a new smart
component.
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{6}SmartComponent_1 SFSmartComponent 5 e =‘tomponent_4
Properties Properties cut Ctrl=X anerties
a (Hella) — < (Hello} Copy ctri=C  F{Hello)
b (World) 1 d (World) B2 | paste ciri-y  [(world)
/0 Signals /0 Signals

Duplicate... |] Signals

Save As Library...

EREN

&

SN C-N N

-
-

Disconnect Library

Protected

Visible Ctrl=D

Examine

L
-~

Unexamine

Set as UCS

Paosition 4
Set Local Origin
Path Planning 3

H WP ile ®

Attach to 4

Auto Connect Signals

Simulate

O

Edit Component
Combine Components
Bl ISpIit Component
TH’ Properties

Split Component

) Tags Split the smart component into
]E Delete the contained smart components.

[# Showunused Zoom: Bistn Arranna - T

Smart Component multi-selection

Smart Components, I/O connections and property bindings can now be multi-selected by keeping the
Shift key pressed down while clicking on the objects in the design view. This makes it easier to move or
delete multiple objects at once. Moving Smart Components can now be undone with Ctrl+Z, which also
works for "Auto Arrange".

He FSmartComponent_1

Froperties
HoFSmartComponent_3 3 3
1/0 Signals PO Shift + click
outputd (0) Froperties
outputd (0) 1/0 Signals
output2 (0] inputd (0}
input1 {0)
He FSmartComponent 2
Properties {=FsmartCom ppnent_4 {8}FSmartComponent_5
IO Signals Properties Properties
output) (0) |- ieiana 110 Signals
output (0) 1 inputl (0} outputl () input (0)
output? (0) input (0) output1 (0] input1 (0)
output3 (0) ] input2 (0)
input3 (0)
I—r input4 (0)

Multiple Smart Components can also be selected by clicking on the background and dragging a
selection rectangle around the Smart Components. If the SHIFT key is pressed while rectangle selecting,
the selected Smart Components are added to the current selection.
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Ho FSmartComponent_1

Froperties
1/0 Signals

HeFSmartComponent_3

Froperties

outputd {0}
output] (0) 10 Signals
output2 (0) input0 (0)
input (0)
[t Click + drag
{2FSmartComponent_2
Properties El:SmarTCompF:nent_4 {&}FSmartComponent_5
1/0 Signals Perfartles Froperties
outputd (0) I8 e /0 Sigrals
output1 (0) inputl (0} outputl (0) inputd (0)
output? (0) input1 (0) output] (0) input1 (0)
output3 (0) input2 (0)
input3 (0)
inputd (0)
16/39
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Improvements

Connect to Controller: Remember Last Opened Tab

Connect to Controller window will now remember the last opened tab and open that one next time the
window is opened.

Safety category in Jobs
It is now possible to select the safety event log category in 'Search Event Logs' and 'Save Event Logs'
jobs.

Keep reference coordinate system when switching selection

The reference coordinate system in tool windows is now kept the same when changing the selected object. This
applies to "Set Position", "Offset Position", "Rotate", "Place object”, "Set Local Origin" and "Duplicate".

Remember settings in Connect to Controller dialog

The check box values in the Connect to Controller window are now remembered between sessions.

Delete Controller /| Start Controller
Local Legin
[] Handle Write Access Automatically

Signal Analyzer: Stress Index signals disabled for non-compact gearboxes

Stress Index signals in Signal Setup will now be disabled for joints that do not have compact gearboxes
with a tooltip describing the reason.

Sort tools and workobjects

Tools and workobjects in the ribbon are now sorted in alphabetical order.

Tool tspindle R
toold
tSpindle I:
tSpindlel
tSpindle2
tSpindle1d

UX improvements in Modify Installation dialog

A number of improvements have been made in Modify Installation dialog in RobotStudio 2023.4 to make
it more user friendly.
Examples of such improvements are the following:
e color coding and icons are used to better visualize changes in the summary
e acustomdialog is now used when creating an Installation Package
e confirmation messages are added when exporting/importing option configuration settings files
e it is possible to view a license contents in the license editor, by positioning mouse pointer on a
license file
¢ latest software versions are displayed first when trying to update and add software
e using name "options" instead of "feature" to better align with official terminology
e customizing software installation order is now accessed via a small button in the Included
Software dialog
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Information

Calibrate camera and save calibration data to a file

In the procedure of calibrating the camera in RobotStudio, it is possible to save the calibration data to a
file on the camera's disk.

Fromversion 2023.4 of RobotStudio, it is necessary to finish the calibration procedure before it is
possible to save the calibration data to a file.
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Corrections

PDD

15104

15188

Fatal error from graphic card related changes
Resolved a critical bug that caused RobotStudio to crash due to graphics card-related errors. These
errors could occurin various situations, such as when the graphics card is forcibly disabled or computer

entering sleep mode. The update features improved error handling, which allows the software to handle
such scenarios more gracefully, preventing crashes and enhancing overall stability.

Path Editor Exception - "An Item with the same key has already been added"

An exception that could occur when opening the Path Editor will no longer do so.

Fatal error when moving a window between tab groups

Fixed a crash that could occur when moving a document window (for example RAPID editor) between
tab groups.

Exception when unpacking Pack&Go with non-English characters

Use of non-English characters sometimes caused exceptions when unpacking a Pack&Go. This is now
fixed.

IRB 5510 base frame notupdated to side of the line

Fixed anissue when creating an IRB5510 system 'From Layout' and selecting a side of the line, the base
frame was not updated accordingly.

VR: Mouse movementin ApplicationWindowPanel

Fixed an issue with simulated mouse movement when using the ApplicationWindowPanel Smart
Componentin VR.

VR: Right-click in ApplicationWindowPanel

When using the ApplicationWindowPanel Smart Component in VR, mouse right-click can now be
simulated by pressing the secondary (grip) trigger on the right-hand VR controller.

VR: IRCS5 Virtual FlexPendantpopups removed

If an ApplicationWindowPanel Smart Component was used to display the IRC5 Virtual Flexpendant in VR,
popups in the FlexPendant (such as Event Log) would not stay open. This issue has been fixed.

ApplicationWindowPanel scaling issue

The ApplicationWindowPanel Smart Component now renders correctly in a multi-monitor environment
with different scaling settings on the monitors.

ApplicationWindowPanel slows down RobotStudio

Fixed anissue with the ApplicationwWindowPanel Smart Component that could slow down RobotStudio
if the specified window was not found.
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PDD

Physics Cable strange behavior when robotis moved

Fixed a bug that could cause a physics cable to become entangled when the object it is attached to is
moved a long distance.

Exception when configuring 1/0 network on E10 controller

The functionality to configure the I/O network is now blocked for controllers that do not have an1/0
network, such as the E10 controller.

Slowresponse when using Snap

Fixed a performance problem that could cause RobotStudio to become unresponsive when "Selection
preview" was enabled and "Snap End" or "Snap Mid" was activated.

System diagnostics from virtual controller

It is now possible from RobotWare version 7.6 and onward to create System Diagnostics on virtual
controllers.

System from layout- IRB5510 system failure state

Fixed anissue where the controller would go into a system failure state if combined with any non-paint
robots. This combination is now not allowed.

UCS icon notappearing

Fixed an issue where the UCS icon would not appearin Paths & Targets tab when setting UCS.

Issue with SetBrush indicators in Path & Procedures view

Fixed a regression introduced in 2023.2 where trigger indicators for SetBrush instructions in the Paths &
Procedures browser were missing. They are now displayed as status icons.

—» PaintL Target_10

[ SetBrush 3\:=2100 )
b SetBrush 2\x:=43.11 Ay
—» PaintL Target_20 | Warning: Trig plane is inside zone |{

—% Pairtl Tarmat W0 TT

Auto Configuration fails

Fixed a an errorin Auto Configuration that could occur if a target was very close to the limits of the
robot working range.

Fatal Error in the Create Controller from Layout window

Fixed a Fatal Error that happened when a specific set of invalid characters ('<', '>', " or'|') where typed
into the Name or Location text boxes in the Create Controller from Layout window.

Error after closing the project

Fixed an error that could occur when interacting with a browser window after the project was closed.
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PDD

Connectto Controller: RobotWare version

In'Connect to Controller > Virtual Controllers' the RobotWare version will now be displayed, rather than
the RobotControl version.

Virtual Controller included in Pack & Go

The whole Virtual Controller folder was included when performing Pack & Go, which could make the
package unnecessarily large. This has been fixed.

SmartComponent- Graphic Switch + Highlighter not working together

Graphic Switch and Highlighter interacted in the wrong way before. Graphic Switch will no longer toggle
a part to become invisible if it's already visible because it is highlighted.

Collision geometryregenerated when notneeded

Previously collision geometries were regenerated even when the shape of objects was unchanged, such
as for translations. They will now be regenerated only when necessary.

Crash when installing under drive root

Fixed a crash that could occur if RobotStudio was installed directly under the root of a drive, e.g. in
C:\RobotStudio.

VR: ApplicationWindowPanel FlexPendantclick issue
Fixed anissue when using the ApplicationWindowPanel Smart Component to display the virtual

FlexPendant in VR. The issue made it hard to click on lines and buttons in the OmniCore code editor,
since a mouse drag operation was started in the FlexPendant instead of a click.

Linear TCP acceleration in world is not supported in Signal Analyzer Online

The signal Linear TCP Acceleration in World was not available for Signal Analyzer Online. It is now
available.

Double popup windows for Outputmessages

Fixed anissue that could cause two popup windows to be shown when double-clicking a message in
Output.

Library files installed under ABB Library notvisible

Library files installed by other products under ABB Library in the RobotStudio installation folder are now
displayed in the "Import Library" menu.

Incorrect controller name in Connectto Controller

In the Connect to Controller dialog, the system name was incorrectly shown under "Controller Name" for
IRC5 controllers. This has been fixed.
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PDD

Custom installation error

If performing a custom installation of RobotStudio with only "RobotStudio Online" selected, the
application could not be started. This has been fixed.

Exception when creating Virtual Controller from backup

Fixed an error that could occur when creating a new Virtual Controller from a backup of a RobotWare
7.12 controller.

Exception when using non-defaultRun Mode Settings

Fixed an exception that happened when changing the operating mode if the Run Mode Settings did not
have default settings.
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Known Limitations
Visual SafeMove
E10 virtual controller not supported

It is not possible to create a valid safety configuration file for a virtual controller where the controller
modelis E10. The device mapping of signals on the internal feedback device will be incorrect. There is no
information about this limitation inside Visual SafeMove because it is currently not possible to know the
model of a virtual controller.

Configurations with Basic Joint Supervision disabled can be created

For SCARA robots, like for example IRB 920T, only the limited functionality Basic Joint Supervision is
supported by the Safety Controller. Visual SafeMove allows the full set of functionality to be configured
even though it is not supported. Writing a safety configuration file with Basic Joint Supervision disabled
results in an error since it is invalid. Workaround: Enable the option Basic Joint Supervision on the robot
node in Visual SafeMove.

Current joint values cannot be retrieved when external axes are included in the configuration

It is not possible to retrieve the current joint values using the Read current values function on the
Synchronization node when external axes are included in the configuration. Workaround: Read the
values from the FlexPendant and update manually.

The safety controller is not forwards compatible

When writing a safety configuration file of a later version than the current safety controller image, then
RobotStudio will generate an error of type “COOFFFE: Unknown error
(OXxCOO4FFFE)LoadSafetyConfigurationFile”. (Note that this error may occur for other reasons as well
and is thus not unique to this case).

The function Get vectors from active tool reads values from the robot

The idea behind this function is to read the data fromthe currently active tool of the robot in order to
define a corresponding SafeMove Tool in the safety configuration. That is the reason why the tool
information is read fromthe robot and not the safety controller. The tools of the safety configuration
are visible the Visual SafeMove itself and does not need a special function to be retrieved.

Protected checksum may change when upgrading RW from 6.04.0x to 6.05 or 6.06

The protected checksum will change if the input and output modules of the internal device is protected.
The reason is that two attributes change order.

No visualization of Safe Range for external axes in Visual SafeMove for SafeMove Basic or Pro

When Safe Range is used to limit the axis range of an external axis such as a track motion, there will be
no visual indication of the actual range in the graphic view.

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu

Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as the command
Default Layout does not recover these windows.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external
axes or positioners. As a consequence, the Online Monitor may show the robot in a non-violating
position, even though the safety controller has detected a safety violation and stopped the robot.
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10 Configurator 6
*Safety configuration problem with PROFIsafe Controller or CIP-Safety scanner

Changing safety settings in Visual SafeMove or 10 Configurator 6 does not always work in conjunction
with the "PROFISafe controller" or "CIP-Safety Scanner" option. Connection with robot controller can be
lost during any IO-configuration, sometimes resulting in that the Flex Pendant reboots. Again this is only
applicable when the PROFISafe controller or CIP-Safety scanner option is present in the system. Problem
is dependent on how many devices are configured on respective industrial network. l.e. EtherNet/IP or
ProfiNet.

Online
Signal Analyzer Online recordings not saved

When recording signals froma real controller with RobotWare 6.13.03 and later, or RobotWare 7.6.1 and
later, there is a sporadic issue which causes the signal changes to not be recorded.

Routine variables can't be displayed in RAPID Watch with RobotWare 6.12

A limitation in RobotWare 6.12 prevents variables declared in a routine from being displayed in the RAPID
Watch window.

Port speed cannot be set at the same time as 'Obtain IP address automatically’

In the Public Network settings dialog the Port speed drop down menu is disabled when 'Obtain IP
address automatically' is selected.

Workaround:

1. Select 'Use the following IP address' and specify any valid IP address.
2. Select the desired port speed and press OK.
3. Select 'Obtain IP address automatically' and press OK.

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the
dropdown menu of the task node in the Controller browser. This is due a restriction introduced with
RobotWare 5.60 and later. However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to
stop can be selected from RobotStudio RAPID tab.

FlexPendant Viewer running with automatic reloading

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time
jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

Online - Paint
Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system
when running RobotWare 5.xx. Workaround: Create the backup of the PIB board with the FlexPaint
Pendant using an USB-stick.

Go Offline does not work for Paint systems

The Go offline function will not create a working Virtual controller system for Paint systemunless the
Paint package I/O option is set to Simulated.

Online - Integrated Vision
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Installation error when having previous versions of RobotStudio or Insight Explorer

If you have a previous version of RobotStudio or Cognex In-Sight software installed, installing a new
version of RobotStudio may result in the following error message

Module C:\Program Files (x86)\ Common Files\ Cognex\ InSight\ 5.7.1674.0\ CvsinSightDisplay.ocx failed
to register. HRESULT -2147220472. Contact your support personnel.

Workaround: To correct the issue, open Windows Settings -> Apps -> Apps & features, select the
current ABB RobotStudio 2019.x, select Modify, and step through the installation wizard and select
Repair. Alternatively, uninstall and reinstall RobotStudio.

Note: Only one version of the In-Sight Display Control can be registered at a time, and this is always the
latest version installed. Although older versions of RobotStudio or In-Sight may seemto function with
this version installed, their compatibility with this version is not guaranteed.

RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50

The user interface of RobotStudio may freeze for up to 60 seconds when configuration Integrated
Vision jobs with the tool PatMax 1-50.

Workaround: Use PatMax 1-10 instead
Remaining error — New Emulators

New camera models have been added to the camera emulator option in RobotStudio 6.04.01. Some of
these new models are not yet fully compatible. Our recommendation is to choose a camera model from
the 7000 series which is fully compatible with Firmware version 4.10.2.

Emulated cameras not discovered when controller in Motors On

For RobotWare 5.61 onwards, the camera discovery mechanismis disabled when the controller is in
Motors On. As a consequence, the camera nodes will not appear in the controller browser.

Workaround: Switch to Manual Reduced Speed and use the Refresh command on the Integrated Vision
node in the browser to make the cameras appear.

Information — Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for
a specific camera model, then the newest version available shall be used. There are two important things
to know before upgrading a sensor:

e The user must make sure to first backup the files on the camera. This can be done using the Rapid
snippets for camera backup/restore, or the FlexPendant Explorer.

e The latest available firmware version may vary across sensor types. However, when the firmware
update utility presents the latest available version it shows the firmware with the highest version
number which may not apply to the sensor to be updated. However, the appropriate firmware will
be applied.

Information - The spreadsheet view

The spreadsheet view is not enabled when editing in the in the following modes “Add part location tool”,
“Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or
Output to Rapid.

Information - Calibration board without fiducial
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When using the calibration boards, checkerboard or board with dots, the user must select the preferred
origin by clicking and accepting (press enter) three points on the board. Only after these three points
have been selected it is possible to click "calibrate" to execute the calibration.

Information - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions
return error code “Communication Error”. The safest method to get default settings is to go to
Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click
“Apply factory settings” in the lower right corner. The most important settings are:

Telnet port: 23
User: "admin"
Password: ""

Information — User Credentials

It is now possible to create user profiles with different access levels on the camera. For detailed
information about this, please refer to the Integrated Vision User Manual.

Remaining error - Save image on camera

It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog
still allows the user to try to do this. The result is that the image is not saved and no error message is
given.

Remaining error - Connect button greyed out for no reason

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is
not on the correct subnet although the IP settings are OK.

Workaround: Restart the Integrated Vision Add-In

Remaining error - VC started from Controller->Add controller does not detect cameras

AVC that is started from Controller->Add controller does not detect cameras on the network, even if
the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that
the controller is not able to detect new cameras on the network when it is in “Motors On” state. When
the VC is started stand-alone in RobotStudio it is automatically set to “Motors On“ when started.

Workaround: To allow it to discover cameras, turn the control panel key to manual mode or launch the
VC as part of a station.

User tip - Removing cameras from configuration

To remove a configured camera fromthe list of configured cameras, use the configuration editor. Enter
Configuration->Communication->Application Protocols and remove the desired camera. Performa
warmstart to complete the operation.

User tip — Viewing all cameras present on the network

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on
the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is
useful when error tracing camera network problems. If a camera does not appear on the network using
the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the
camera receives power fromthe controller, then cycle power by turning the mains switch.

User tip — Warm start the controller after changing network settings
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Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect-
>Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will
give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP
address is used and persist, please try a static address instead.

Offline

Point cloud data in JT files can't be imported

Point cloud data in JT files is not imported by RobotStudio.
Issue with collision avoidance for palletizer robots

When configuring collision avoidance for a palletizer robot using RobotWare 6.11, attaching an object to
a mechanismlink can result in an error and the configuration will not be loaded.

The YuMi library revision 1 cannot be successfully updated to YuMi revision 2

When opening a Pack&Go file with a station that has a reference to 1RB14000 0.5 0.5 01.rslib you
get the option to update it to the newer IRB14000_0.5_0.5_ 02.rslib.

The following issues occurs if you select ‘Yes’ and update the model:

e The attached parts, for example Smart Grippers, are detached.
e The new YuMirobot is not connected to the virtual Controller.
e The old YuMi mechanismis converted to a component.

Answer ‘No’ to this question to keep the original revision 1 model and avoid the problems mentioned
above.

RobotStudio needs to be restarted to update a modified library instance

When editing a library file (.rslib) that is used in a currently open station, then RobotStudio needs to be
restarted to update the library. Simply re-opening the station is not enough to update the content of
the station. Unless RobotStudio is restarted, the old library instance will remain in memory and be loaded
even though the underlying file has been updated. This is a known limitation and is expensive to fix.
There is a workaround to the problem, which is to restart RobotStudio.

The robot IRB 1600ID 1.55 m / 6kg replaced by IRB 1660ID1.55 m / 6 kg in RobotWare 6.04

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to
IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m/ 6 kg based on RobotWare 6.03
cannot upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on
RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically

Workaround: Re-build or modify the virtual controller systemto use IRB 1660ID 1.55 m / 6 kg instead
when using RobotWare 6.04 or later.

FlexPendant and RAPID applications run with logged in user rights

A FlexPendant or RAPID application running on the virtual controller runs with the rights of the logged-in
Windows user. RAPID applications running in a background task will start to execute when the Pack&Go
file is opened and FlexPendant applications will start to execute when the user starts the Virtual
FlexPendant. A warning message has been added to the Unpack&Work wizard to make the user aware
that only Pack&Go files (.rspag) fromtrusted sources shall be opened.
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Unpack & Work

Select package

Select the Pack & Go file to unpack ST
|C:‘\Users"».ABB‘LDo-:uments\.Ruth Studio®\Stations".Demo Bhaust Pipe.rsp Browse...

Target folder:
| C:\Users"ABB"\Documents‘\Robot Studio®Sclutions’Demo Exhaust Pipe Browse...

Unpack to Solution

1 Only open Pack & Go files from trusted sources.

Help Cancel < Back MNead >

Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries
created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02
or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created
in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04

TrueMove path visualization fails for customized zone data

The TrueMove path visualization function only supports predefined zonedata. It will not work for user
defined zonedata.

Backup fails for RobotStudio solutions with SafeMove or Electronic Position Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution
when saving the station. For virtual controller systems with the RobotWare options SafeMove or
Electronic Positioning Switches the backup will fail since these systems contain files that are read-only.
As a result, an error message is presented in the output window: <System name>: Backup failed.The
station will be successfully saved but there will be no backup created. Workaround: Ignore the error
message <System name>: Backup failed and create a manual backup whenever needed. The
RobotStudio Option “Enable automatic backup of controllers in solution” that is available in
"RobotStudio Options -> Robotics -> Virtual Controller” can be de-selected to disable the backup
function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB
14000. The reason is that the IRB 14000 cannot be combined with any other robot.

Workaround: Create a separate systemfor the IRB 14000.
The Work Envelope function does not support IRB 14000
The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models
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As a result, the generated work envelop may appear distorted.
Update of current selection in the 3D graphics window may be delayed

A problemrelated to the graphics driver has been observed on certain PCs. The problemis that the
update of the current selection in the 3D graphics is delayed until the next redraw.

Workaround: Add or uncomment the following line in the file RobotStudio.exe.config
<add key="DoublePresentWorkaround” value="true” />

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station
contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller
configuration file to be accidentally overwritten.

Workaround: Remove the write protection manually using Windows Explorer.
Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets
files in the folders:

...\My Documents\ RobotStudio\ Instruction Templates
...\My Documents\ RobotStudio\ Code snippets

Workaround: The user has to manually copy the latest files from

%Programfiles %\ ABB Industrial IT\ Robotics IT\ RobotStudio 5.xx\Instruction Templates
and

%ProgramFiles %\ ABB Industrial IT\ Robotics IT\ RobotStudio 5.xx\ Code Snippets

to the data folder.

I/0 signals configured with access level 'DEFAULT"

When IO signals are configured with access level 'DEFAULT', only input signals are possible to set/reset
fromthe I/0 Simulator and I/O Window. To be able to affect also output signals, set the access level to
‘ALL’ for themin the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference
Interface) if the GSl folder structure is missing.

Workaround: Create GSI Folder before starting the VC inside the HOME directory of the system. See the
Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller systemto enter Guard Stop state in Automatic mode.
This is the same behavior as in a physical robot controller system. This typically happens when a run-time
error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this
state.

Workaround: To reset the controller state, open the Control Panel window and first switch to Manual

© Copyright 2023 ABB. All rights reserved. 29/39



mode, and then back to Automatic mode.
Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing
via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an
Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals
The event manager only supports analog station signals, not analog system signals.

Conveyor Tracking

*Conveyor objects must be re-added for stations created prior to RS 6.05

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects
must be re-added.

Incorrect default values for clPosition and c1Speed for RobotWare 5 with the PaintWare option

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual
controller system. The symptomis that its attribute values are all zero, see snapshot below.

Workaround: Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual
controller followed by a restart.

EIO:CFG_1.0:5:0::
#
EIO_SIGNAL:
-Name "clPosition" -SignalType "AI" -Unit "CnvIf"\
-SignallLabel "ctPosition" -UnitMap "©-31" -Access "ALL"\
-MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
-MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
-MinBitVal -2147483647
-Name "cl1Speed" -SignalType "AI" -Unit "CnvIf" -Signallabel "ctSpeed"\
-UnitMap "32-63" -Access "ALL"\
-MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
-MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
-MinBitVal -2147483647

MultiMove
MultiMove error: ‘Object reference not set to an instance of an object’

When the Test Play button is pressed in the MultiMove tool, the following error message may be
displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status
‘Calculation OK’ is displayed. In addition, when ‘Create Paths' is pressed the following message is
displayed: ‘Can't create paths : Value cannot be null', and no paths are created. In the ‘Create Paths
Settings’, is the WP TCP drop down empty.

Reason: Workobject is not set for the current task.

External Axis
Error 50091: ‘Restart not possible’ after warm start of a system with external axis

When restarting a systemwith activated mechanical units the activation state is lost. Then the program
can no longer be started fromthe Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

Workaround: Reset the program pointer (‘Program Pointer to Main’) before starting the programfrom
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the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program fromthe
Simulation Play button.

Network Drives and UNC Paths
RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents
folder resides on a server and not on the local disk.

Workaround: Redefine the 'User Project Folder’ to a folder on the local disk (File — Options — General —
Files&Folders — User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will
cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts.
Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare
mediapool, the following problems may occur:

e Virtual controller does not start
e Not possible to open Virtual FlexPendant

Cause: By default, the .NET Framework does not allow execution of code froma remote file system. This
means the application may behave unexpectedly if the media used by the system or the systemitself
resides on a network share.

Workaround: To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.configlocated in C:\Program Files (x86)\ABB Industrial
IT\Robotics IT\RobotStudio 5.61\ Bin

2. Add the following lines:

<?xml version="1.0"?>
<configuration>
<startup uselLegacyV2RuntimeActivationPolicy="true">
<supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>

</startup>
<runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
<loadFromRemoteSources enabled="true"/> <!-- THIS IS ONE OF THE NEW LINES!!! -->
</runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
</configuration>

The Virtual FlexPendant must be restarted for the changes to take effect. For further information, see
http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx

RAPID
Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice
versa does not support robtargets that are declared locally to a procedure.

Workaround: Declare the robtargets as global or local to a module instead.
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Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly,
i.e. you cannot have a global robtarget named pMyTargetl in module A and a local robtarget with the
same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through Synchronization to VC, the option is disabled
(PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data name type has same name as existing
object in same block routine.

When this error message appears, there is a storage type mix-up between data already stored in RS and
in the VC. Because of this, and per design, the data is not considered the same data.

Workaround:

1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface
for this).

2. Sync to station should now work.

3. Sync back to controller, and remember to change the data declarations back to what you want.

Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.
The new conveyor tracking module DSQC2000 is not supported for paint robots.
Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus,
will result in a SysFail state.

Workaround: Re-create the systemwith the simulated I/O option.

Graphics and Geometry
*Display of working range optimized for furthest reach

The current algorithm uses a fixed value for joint five which gives the furthest reach for a given tool. The
sweep is not optimized to get the shortest reach on the "inside" of the working area.
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Enforce selected graphics device for PCs with multiple graphics cards

For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can
be configured to use a specified device. By this option you can ensure maximum performance. This is
useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA
card.

Open the file RobotStudio.exe.configthat is located in the folders
C:\Program Files (x86)\ABB Industrial IT\ Robotics IT\ RobotStudio x.y\ Bin64
and

C:\Program Files (x86)\ABB Industrial IT\ Robotics IT\ RobotStudio x.y\Bin

and uncomment the line:

<add key="GraphicsDeviceType" value="Discrete"/>
Valid values are 'Discrete’, 'Integrated' and 'Warp' (software renderer). Note that there are two different
files, one for the 32-bit version, and another for the 64-bit version.
Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover fromthese problems, you need to delete
the items that caused the problem

ScreenMaker
Numeric controls and decimal separators

To use numeric controls in ScreenMaker on the PC set the decimal symbol to a single period ('."). Other
decimal symbols are not supported and binding values will not work in the Virtual FlexPendant. The
behavior on the real FlexPendant is not affected by this PC setting.

Graphs on secondary screens

To use a Graph on a secondary screen (not the main screen) a customaction is needed. Otherwise, the
Graph will not be updated properly. In the ScreenFormthat contains the Graph add a Load event. In this
event add an action using Add Action->Advanced->Call Custom Action. Select the Graph control and the
UpdateValues action.
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Type Description

Control:

graph v

Are you sure you want to perf Action:
UpdateValues w

(] Show waming message before performing actions Cancel

Binding to the Enabled property

Connecting the Enabled property of any control to a BOOL variable or IO signal may not work as
expected. The variable or signal may be inadvertently changed leading to unexpected behavior. Instead,
bind to a digital output where the Access Levelis set to ReadOnly

A ScreenMaker cannot be deployed a controller with disabled Default User
Workaround: Enable the Default User.
NumEditor in ScreenMaker disables the controls in a group box or panel

If you are using the NumEditor controlin a group box or a panel, and that box or panelis enabled by an
input signal, then all other controls of that group or panel will become disabled if the editor is opened
and closed.

Button with multiple states in ScreenMaker app do not update the images if button is disabled

For an app which uses Buttons with multiple states connected to images that change depending on the
value of a RAPID variable, then if the button is disabled, the button shows the greyed image of the state
which was active when the disabled state was shown the first time.

ScreenMaker fails for RobotWare 5.12

ScreenMaker fails to build applications for RobotWare 5.12.
Workaround: Update to a later RobotWare version.

A ScreenMaker application may fail to build if the DPI setting is not set to 100%

Certain Ul controls in ScreenMaker may fail to build correctly if the DPI setting is not set to ‘Smaller —
100%'.

Symptom: The error message caused by this problem will read ‘System.Drawing.Font’ does not contain a
constructor that takes 2 arguments.

Workaround: Set DPIto 100% on your PC.

File changes to FlexPendant applications does not load the changes until a FlexPendant reset

With RobotWare 6.0x the controller's restart will no longer reset the FlexPendant memory. This was part
of an effort to improve the restart time of the controller. This means that after placing a new
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FlexPendant application file(s) on the FlexPendant unit, you need to manually reset the FlexPendant for
it to reload its assets.

To manually reset the FlexPendant you need to use the reset button on the FlexPendant's backside. (See
Operating Manual - IRC5 with FlexPendant, 3HAC16590)

Running Routine with Movement

RunRoutine Button control does not always work correct when a routine with movements is called. As a
workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the
movements of the robot. A Trap routine could be called with a normal button control and in the Trap the
above instructions can be used to control the movements of the robot.

PictureBox control as a Widget

If a Picture Box controlis created as a widget froma Windows 8 operating system, the control is not
shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.
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RobotWare Compatibility
Supported RobotWare versions

RobotStudio works with RobotWare 5.07 and later. Please check details below. The latest supported
RobotWare version for IRC5 and OmniCore controllers is stated under Help/About in RobotStudio.
RobotWare packages can be added to RobotStudio fromthe Add-Ins Gallery window.

RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later
versions. Please use the corresponding version of RobotStudio for managing robot controllers with any
of these RobotWare versions.

RobotWare 5.07 Compatibility

General

The location of the program pointer is not updated in the RAPID Editor during program execution.
Offline

A limitation in the versions 5.07.02, 5.07.03, and, 5.07.04 of RobotWare may cause the Virtual Controller
to System Failure state during l-start on certain computers. The problemis due to the ctrl.bin-file not
being correctly created.

Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then
performa warm start.

Note: The problem will reappear if the systemis I-started. The virtual controller does not support
RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07.

RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions of are supported with the following limitations:
Offline

RobotWare 5.08 is not supported.
Workaround: Use RobotWare 5.08.01 or later.

RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions of are supported with the following limitations:
Offline

Starting a controller will generate internal UAS error in controller error log.
RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions of are supported with the following limitations:
Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example,
if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to
stop or to change configuration.
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RobotWare 5.12 Compatibility
RobotWare 5.12 and its revisions of are supported with the following limitations:
Paint

Paint backups fromRW 5.12.01 are not compatible with RW 5.12.02 or later. Restoring a paint system
backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later.

Workaround: Add the following parameters to the configuration files:

EIO.CFG

EIO_SIGNAL:

-Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
-Name "AlHVErrNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"\
-Access "ALL"

-Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"\
-Access "ALL"

EIO_CROSS:
-Res "A1HVEn" -Actl "HVEnabled"

SYS.CFG:

CAB_TASK_MODULES:

-File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"\
-Task "T_ROB1"

-File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask \
-Hidden

RobotWare 5.13 Compatibility
RobotWare 5.13 and its revisions of are supported with the following limitations:
Paint

Paint backups fromRW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW
5.13.03. There are several changes in the configuration database for I/O (EIO.CFG) and Controller
(SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed
RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your
original backup, but do not load the backup.

2. Save the EIO.CFG and SYS.CFG to file.

3. Compare the saved files with the corresponding files of your backup. (You can use a text file
comparison tool for simplification.)

4. Add your system-specific configuration to the general configuration files saved fromthe 5.13.01-
systemusing a text editor.

5. Replace the files of the original backup with the corresponding modified configuration files.

6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are
not changed by the user).

7. Load the backup and restart the system You are done.

RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.

© Copyright 2023 ABB. All rights reserved. 37/39



RobotWare 6 Compatibility
Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a
system, you need to create backup and migrate it using the tool ‘Migrate Backup or Folder’, then
recreate the systemand finally, restore the backup. For this reason, the functions ‘Unpack&Work’, ‘Go
Offline’ and ‘New Solution with Station and Robot Controller — From backup’ are blocked to prevent
upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01. RobotStudio, however, is compatible with
both RobotWare 6.00 / 6.00.01 and 6.01.

General Compatibility Limitations
Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or
SafeMove can be done without the need to read track motion parameters manually when using
RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically
read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present
all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or
earlier is used.

Workaround: Upgrade to RwW5.14.01 or later

© Copyright 2023 ABB. All rights reserved. 38/39



Compatibility

Modify Installation dialog and Add-Ins incompatibilities

"Modify Installation dialog" is a new dialog in RobotStudio 2023.3 and 2023.4 that replaces Installation
Manager 7, which is now deprecated. It has a new way to visualize Options selections and handle
dependencies between options.
Add-In Packaging Tool is used to define Add-Ins metadata and package them It currently allows more
freedom than recommended and supported by "Modify Installation dialog" . The result can be that some
Add-ins may not be handled as expected. The main constructs that should be avoided when defining
your RobotWare Add-Ins are the following:

e circular dependencies between options

e dependencies between options that have parent <--> child relationships in the view (not

necessary any more, since child nodes are never visible or selected until their parent is selected)

For full list of recommendations, please refer to appendix B in Application manual - RobotWare add-ins
3HACO070207.

Add-In Packaging Tool shall be updated in the coming releases to follow the new guidelines for defining
Add-Ins.
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